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1.  ORDERING GUIDE, SERIAL INPUT TRANSMITTER 

Configure a model number in this format: LTS60, CBL04 

LTS6…Transmitter with 4-20 mA, 0-20 mA, 

0-10V or -10V to +10V isolated analog 

output, RS232 or RS485 serial data 

input, and dual 120 mA solid state 

relays. Default jumpered for RS232. 

 LTSE6E… Transmitter with 4-20 mA, 0-20 

mA, 0-10V or -10V to +10V isolated 

analog output, Ethernet serial data 

input, and dual 120 mA solid state 

relays. 

Power 

0............................. 85-264 Vac or 90-300 Vdc 

1................................. 12-30 Vac or 10-48 Vdc   

ACCESSORIES 

CBL04……RS232 cable, two 3-pin connec-

tors on transmitter end, DB9 

connector on computer end. 

CBL02……USB to DB9 adapter cable. Can 

be used with CBL01 or CBL04. 
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3.  INTRODUCTION, RS232 OR RS485 SERIAL INPUT TRANSMITTER 

 
 

The LTS6 serial input to analog output transmitter (or serial-to-analog converter) accepts 

RS232 or RS485 serial data using the Modbus or Custom ASCII protocol, and converts it to an 

isolated, scalable 4-20 mA, 0-20 mA, 0-10V or -10V to +10V analog output. The unit fits on a 

35 mm DIN rail and is only 22.5 mm (0.89") thick. It is normally powered by AC (85-264 Vac), 

but can optionally be powered by low voltage AC or DC. All electrical connections are via 

detachable screw-clamp plugs. A separate manual covers the LTLTLTLTSESESESE6666 serial input to analog 

output transmitter, which accepts Ethernet data and converts to an isolated, scalable 4-20 mA, 

0-20 mA, 0-10V or -10V to +10V analog output. 

The current or voltage transmitter output is jumper selectable and is transformer isolated to 

avoid ground loops. Either output provides 16-bit resolution of the output span and is ultra-

linear to within one bit. The output is scaled to the serial input in software. Output accuracy is 

±0.02% of span. 

Dual solid state relays rated 120 mA at 140 Vac or 180 Vdc are standard. The relays can 

respond to the transmitted serial values or to transmitted control characters, which override the 

internal setpoints. The relays can also be controlled independently of the serial input by 

applying signals to control inputs 1 and 2.  

Isolation to 250V rms is provided for power, the serial data input, analog output, and relay 

outputs. Isolation adds safety and avoids possible ground loops. 

Default serial settings are for RS232 and full-duplex RS485. Half-duplex RS485 can be 

selected via jumpers or external wiring.  

Transmitter setup is via the unit’s serial port using an external PC and Instrument Setup 

software. This software can be downloaded from our website at no charge. The required 3-wire 

transmitter-to-PC interface RS232 cable is easy to build and is also available for purchase. 

 

4.  RECEIVING & UNPACKING YOUR TRANSMITTER 

 

Your transmitter was carefully tested and inspected prior to shipment. Should the transmitter be 

damaged in shipment, notify the freight carrier immediately. In the event the transmitter is not 

configured as ordered or is inoperable, return it to the place of purchase for repair or replacement.  

Please include a detailed description of the problem. 
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5.  SAFETY CONSIDERATIONS 

 
 

 Warning: Use of this transmitter in a manner other than specified may impair the protection 

of the device and subject the user to a hazard. Visually inspect the unit for signs of damage. If the 

unit is damaged, do not attempt to operate. 

Caution:  

• This unit may be powered with AC (mains) from 85-264 Vac or 90-300 Vdc with the high 

voltage power supply option, or 12-30 Vac or 10-48 Vdc with the low voltage power supply 

option. Verify that the proper power option is installed for the power to be used. This 

transmitter has no AC (mains) switch. It will be in operation as soon as power is applied. 

• The 85-264 Vac or 90-300 Vdc mains connector (P1 Pins 1-3) is colored green to differentiate 

it from other input and output connectors. The 12-30 Vac or 10-48 Vdc mains connector is 

colored black. 

• To avoid dangers of electrocution and/or short circuit, do not attempt to open the case while 

the unit is under power. However, signal wiring changes external to the case can be made 

safely while the unit is under power.   

• To prevent electrical or fire hazard, do not expose the transmitter to excessive moisture. 

• Do not operate the transmitter in the presence of flammable gases or fumes. Such an environ-

ment constitutes an explosion hazard.  

• Secure the transmitter to a 35 mm DIN rail. 
 

Symbols used: 

 

Caution (refer to accompanying 

documents)    
 

 
Caution, risk of electric shock.    

 

Equipment protected throughout  

by double insulation or reinforced 

insulation.    

 
Earth (ground) terminal. 

 Both direct and alternating current. 
  

Operating environment: 

• Class II (double insulated) equipment  

designed for use in Pollution degree 2. 

PROVISION FOR COOLING 

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

AL 1

AL 2

RESET

POWER

 
 

To avoid overheating, mount transmitters 

�with ventilation holes at top and bottom. 

Leave a minimum of 6 mm 1/4” �) between 
transmitters, or force air with a fan. 
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6.  TRANSMITTER FIELD WIRING 
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7.  JUMPER SETTINGS 

 

 

Serial Signal Duplex Jumpers Termination Resistor* 

RS485 
Full None 

E6 a = Transmit 

E6 c = Receive 

Half E6 b + d** E6 c 

RS232 Full None None 

*  The termination resistor jumper settings should only be selected if the transmitter is the last 

device on an RS485 line longer than 200 feet (60 m). 

**  Or connect external BTX to BRX and ATX to ARX (same effect as internal jumpers). 

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1, cycle power, remove the jumper, and restart the transmitter.  
 

Analog Output J4 Pins Jumpers 

Current, 4-20 mA 1 Lo, 2 Hi E2 a + d 

Voltage, 0-10V 1 Lo, 2 Hi E2 b + c 

Voltage, -10V to +10V 3 Lo, 2 Hi E2 b + c 
 

Excitation Output Jumpers 

5V, 100 mA E3 a + c; E4 a 

10V, 120 mA E3 a + c; E4 b 

24V, 50 mA E3 b, E4 none 
 

Notes:Notes:Notes:Notes:  1.1.1.1. Jumper settings are for counter main board Rev J. 

2.2.2.2. Attempting to draw more than rated excitation output current will shut down the output. 

3.3.3.3. The analog output is sourcing. Do not apply an external voltage. Applying an external 

voltage of 24 Vdc will burn out the transmitter main board. 
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WHEN TO CHANGE JUMPERS 

Your transmitter case does not need to be opened if jumpers have already been set by your 

distributor. Otherwise you will need to open the case and either set jumpers or verify that the 

factory default jumpers positions will meet your needs. Factory default jumper settings are for 

RS232 input and 4-20 mA output. 

HOW TO OPEN & CLOSE THE CASE 

  
 

The two clamshell halves of the case are held together with a bolt and a nut at each of the four 

corners. Use a Phillips screwdriver to remove the four bolts. The nut will then drop off, and the 

clamshell halves will separate. When closing the case, make sure that the ventilation grills are 

properly aligned.  

 

Caution: The nuts at each corner are not captive and are black. Take precautions so 

that the nuts do not get lost.  
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8.  PROGRAMMING YOUR TRANSMITTER 

 

OVERVIEW 

Serial input transmitters are programmed using a PC with an RS232 port and Instrument Setup 

(IS) software, which provides a graphical user interface. The software allows uploading, editing, 

downloading and saving of setup data.  

CONNECTING TO YOUR PC 

Use a 3-wire RS232 cable (P/N CBL04) to connect your transmitter to the COM port of your PC. 

Download the file ISx_x_x.exe from our website and double-click on the file name. Click on 

“Install Instrument Setup Software” and follow the prompts. To launch IS software, press on 

Start => Programs => IS2 => Instrument Setup or on the desktop icon that you may have 

created. Following a brief splash screen, the Communications Setup screen will appear. 

ESTABLISHING COMMUNICATIONS 

 

In the Communications Setup screen, select Custom ASCII as the Protocol, as this is the 

factory default setting. Select Transmitter LT as the Device Type. Then click on the RS-232 

(USB) button. In the resulting Establish Communications screen, select your Com Port and 
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9600 as the Baud Rate. You will be able to change your protocol and baud rate later under the 

Communication setup tab. Click on Establish, and the two fields at the bottom of the screen 

should turn green and display your communication parameters and the counter-transmitter 

revision level. Click on Main Menu. The computer will remember your communication settings 

for the next time that you run IS software.  

 

The best way to learn IS software is to experiment with it. From the Main Menu, click on 

Counter  => Get Setup to retrieve (or get) the existing setup data from your counter-transmitter. 

Click on View => Setup to bring up screens which allow you to easily edit the setup file using 

pull-down menus and other selection tools. You can download (or put) your edited file into the 

transmitter by clicking on Counter => Put Setup. You can save your setup file to disk by clicking 

on File => Save Setup and retrieve a previously saved file from disk by click on File => Open. 

After selecting a screen input field, pressing the F1 key will bring up detailed help information 

for that field.  
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SETTING UP BASIC OPERATION 

 

Under the Input+Display tab, select 000.00 Secs for Time Out. Ignore Signal Input, Gate Time, 

Filter, and Power-On Total, as these parameters do not apply to the serial input transmitter. 

Under Display, select the Remote A, Remote S or Remote C operating modes, which are 

explained under the “Custom ASCII Protocol Transmitter Communications” section of this 

manual.  

The Control Inputs pull-down menu controls the effect of grounding Control Input 1, Control 

Input 2, or both.  Selections applicable to the serial input transmitter are the following: 

• Meter Reset, Function Reset, Meter Reset (first row). When this row is selected, grounding 

Control Input 2 (causes a function reset, which resets latched alarms. 

• Activate Alarm 1, Activate Alarm 2, Activate Alarm 1&2. When this row is selected, ground-

ing Control Input 1 activates relay 1, grounding Control Input 2 activates relay 2, and 

grounding both inputs activates Alarms 1 & 2.  

• Tare Enable, Tare if Enabled, Tare (last row). When this row is selected, grounding Control 

Input 1 (normally with a permanent connection) enables the Tare function. Momentarily 

grounding Control Input 2 stores the current digital value as an offset and subtracts this 

offset from the digital reading sent to the transmitter, resulting in a zero value for alarms and 

the analog output. This offset will also be subtracted from all new readings sent to the 

transmitter. To change the offset, momentarily ground Control Input 2 for the new input.  
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SETTING UP COMMUNICATIONS (REMOTE A & S MODES) 

 

The above screen will appear under the Communication tab if Remote A or Remote S has been 

selected as Display Type under the Input+Display tab. These two modes are not able to extract 

data from an ASCII string that contains multiple data values and non-numeric characters. 

Under this tab, you can reselect your Baud Rate, Device Address, Serial Protocol, and Full/Half 

Duplex, even though you may have selected different values to establish initial communications 

with your PC. 

Set Output Mode to Command. Ignore the setting for CR(LF), Output Items, Output Filter, and 

Output Rate, as these items apply to digital transmission by a counter-transmitter, not to 

digital-to-analog conversion by the serial input transmitter.  
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SETTING UP COMMUNICATIONS (REMOTE C MODE) 

 

The above screen will appear under the 

Communication tab if Remote C has 

been selected as Display Type under the 

Input+Display tab. This mode is able to 

extract data from an ASCII string that 

contains multiple data values and non-

numeric characters. Please see the F1 

Help screen to the right. 

Under this tab, you can reselect Baud 

Rate, Device Address, Serial Protocol, 

and Full/Half Duplex, even though you 

may have selected different values to es-

tablish initial communications with your PC. 

Set Output Mode to Command. Ignore CR(LF), Output Items, Output Filter and Output Rate, as 

these items apply to digital transmission by a counter-transmitter, not to digital-to-analog 

conversion by the serial input transmitter.  

The number of characters shown can be up to 7, including 6 digits and a decimal point. Include 

leading zeros, such as 00300.0 
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SETTING UP THE ANALOG OUTPUT 

 

Under the Analog Out tab, set Source to Item 3. Under Range, select 0-20 mA, 4-20 mA, 0-10V 

or -10V to +10V as your desired analog output. Enter your Lo Range Reading and Hi Range 

Reading. These will create the two endpoint values of your analog output range. Only enter the 

numerical values. The decimal point is ignored. The span between the two values should be at 

least 256 counts. 
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SETTING UP RELAY ALARMS OPERATION 

 

Dual AC/DC solid state relays rated 120 mA are standard for alarm or setpoint control and are 

independently set up via the “Relay Alarms” tab. Set “Alarm Source” to “Item 3” as illustrated. 

For online help with any data entry field, press the F1 key.  

• Setpoint. The number to which the current reading is compared if deviation is set to zero. The 

reading is the count in engineering units that is transmitted digitally and is also used for analog 

output. For example, if the transmitted reading is in gallons/minute, the setpoint will be 

referenced to that reading, not to the raw pulse rate sent from a turbine flow meter. 

Time
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 “Active High” On/Off setpoint control 

with deviation =0 
 “Active Low” On/Off setpoint control  

with deviation = 0 
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• Deviation. A positive number that can be added or subtracted from the setpoint, depending on 

the Deviation Type, to determine when an alarm becomes Active or Inactive.  

• Alarm Source. Depending on the Signal Input Mode and Function selected under the Input+ 

Display tab, the alarm can be assigned to any of up to three Items, for example to Item 1  

(A rate / B rate), Item 2 (A rate), or Item 3 (B rate). 

• Alarm State. If “Active High” is selected, the Active Alarm State is defined as being above the 

setpoint. If “Active Low” is selected, the Active Alarm State is defined as being below the 

setpoint. If “Disabled” is selected, the Alarm State is always inactive. 

• Relay State. A setting with ties the Relay State to the Alarm State. If “Active On” is selected, 

the relay will be closed when the Alarm State is 1. If “Active Off” is selected, the relay will be 

open when the Alarm State is 1. 

• Deviation Type. Three choices are offered: Split Hysteresis, Span Hysteresis, and Band 

Deviation. These define how Setpoint and Deviation are to be combined to set Alarm State. 

 

        Span Hysteresis for heater control      Band Deviation for component testing 

In Split Hysteresis, the relay opens (or closes) when the reading goes above the Setpoint plus 

one Deviation, and closes (or opens) when the reading falls below the Setpoint less one 

Deviation. Two Deviation limits lie symmetrically around the Setpoint to create a deviation 

band. A narrow hysteresis band is often used to minimize relay chatter. A wide band can be 

used for on-off control. 

In Span Hysteresis, operation is as for Split Hysteresis, except that the Setpoint is always on 

the high side, and a single Deviation lies below the Setpoint to create the hysteresis band. 

Span Hysteresis is considered by some to be more intuitive than Split Hysteresis. 

In Band Deviation, the relay opens (or closes) when the reading falls within the deviation 

band, and closes (or opens) when the reading falls outside. Two deviation limits lie symmetric-

ally around the setpoint to create the deviation band. Passbands around a setpoint are often 

used for go-no-go component testing. 
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• Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is only 

closed (or open) while the Alarm State is Active. Under Latching, the activated relay remains 

closed (or opens) until reset regardless of the Alarm State. Resetting is normally achieved by 

temporarily grounding one of the transmitter’s control inputs, which has been set to Function 

Reset under the “Input+Display” tab. 

• Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the number 

of consecutive alarm readings that must occur to create an Active alarm. Numbers higher than 

2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an Active Alarm. The 

Alarm becomes Inactive if one of the consecutive readings fails to be an Alarm reading. The 

Alarm readings counter then resets to 0. 

 

 

9.  PUTTING YOUR PROGRAMMED SETUP INTO THE LTS6  

 

After you have completed all of your settings in Instrument Setup Software, click on the Main 

Menu button. From the Main Menu, click on the Counter tab and do a Put Setup. This will 

download your setup from the PC into the LTS6. Then exit Instrument Setup Software 

completely and disconnect your LTS6.  

REMOTE C WARNING: 

Failure to exit Instrument Setup software completely will take the LTS6 out of the Remote C 

mode back into the Remote A mode, which allows two-way serial communications between 

the PC and LTS6. 

Reconnecting the LTS6 to a PC and using Instrument Setup Software, for example to check on 

previously programmed settings, will also take the LTS6 out of the Remote C mode back into 

the Remote A mode. In that case, you will need to reset the LTS6 to Remote C and do a Put 

Setup to download your setup from the PC into the LTS6. 
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10.  MODBUS PROTOCOL TRANSMITTER COMMUNICATIONS  

 

1.  GENERAL 

The Modbus capability conforms to the Modbus over Serial Line Specification & Implemen-

tation guide, V1.0.  Both the Modbus RTU and Modbus ASCII protocols are implemented: 

Modbus RTU 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 start bit, 8 data bits, 1 parity bit, 1 stop bit (11 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 11 total) 

Address .............. 0 for broadcast, 1-247 for individual devices 

Modbus ASCII 

Baud Rate ........... 300, 600, 1200, 2400, 4800, 9600 or 19200 

Data Format ....... 1 Start bit, 7 Data bits, 1 Parity bit, 1 Stop bit (10 bits total) 

Parity .................. None, Odd, Even (if None, then 2 Stop bits for 10 total) 

Address .............. 0 for broadcast, 1-247 for individual devices 

2.  FRAMING 

Modbus RTU: Message frames are separated by a silent interval of at least 3.5 character times. 

If a silent interval of more than 1.5 character times occurs between two characters of the 

message frame, the message frame is considered incomplete and is discarded. Frame Check = 

16 bit CRC of the complete message excluding CRC characters. 

Modbus ASCII: The message begins immediately following a colon (:) and ends just before a 

Carriage Return/ Line Feed (CRLF). All message characters are hexadecimal 0-9, A-F (ASCII 

coded). The system allowable time interval between characters may be set to 1, 3, 5 or 10 

seconds. Frame Check = 1 byte (2 hexadecimal characters) LRC of the message excluding the 

initial colon (:) and trailing LRC and CRLF characters. 

3.  ELECTRICAL INTERFACE 

Two-wire (plus common) half-duplex RS485 or RS232 signal levels are jumper selectable on 

the transmitter main board. The RS485 selection provides a jumper selection for insertion of a 

line termination resistor. Please see Section 14. In case of a long line (greater then 500 ft) to 

the first device, a termination resistor should be selected for the first device. In case of a long 

line between the first and last devices, a termination resistor should be selected for the first and 

last devices. Never add termination resistors to more than two devices on the same line. 
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4.  COMMUNICATIONS SETUP 

Parameters selectable via downloaded Instrument Setup software: 

Serial Protocol ............................... Custom ASCII, Modbus RTU, Modbus ASCII 

Modbus ASCII Gap Timeout ........... 1 sec, 3 sec, 5 sec, 10 sec 

Baud Rate ....................................... 300, 600, 1200, 2400, 4800, 9600, 19200 

Parity  ............................................. No parity, odd parity, even parity 

Device Address  ............................. 0 to 247 

5.  SUPPORTED FUNCTION CODES 

FC10:  Write Multiple Registers (FC10 = 16 dec) 

Writes internal registers containing input data for analog output and relays. 

Register Address 
Data Type Destination 

Dec Hex 

107 006B Hi Word Hex Value Hi Word Applied to Item3 

108 006C Lo Word Hex Value Lo Word Applied to Item3 

 

FC05:  Write Single Coil 

Action command to transmitter 

Output Address Output Value Action Command 

00 01 FF 00 Transmitter Reset  (No Response) 

00 03 FF 00 Latched Alarm Reset 

6.  MESSAGE FORMATTING 

MA = Device Address          DD =   Data (Hex)        CL =  CRC Lo Byte 

FC = Function Code           WW = Data (On/Off)     CH = CRC Hi Byte 

RA = Register Address        SF = Sub-Function      CR = Carriage Return 

NR = Number of Registers    EC =  Error Code        LF = Line Feed 

NB = Number of bytes         LRC = ASCII Checksum 

Modbus RTU Format 

FC Action 
> 3.5 

Char 

Byte Number 

1 2 3 4 5 6 7 8 9 10 11 

05 

05 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

CL 

CL 

CH 

CH 

   

10 

10 

Request 

Response 

NoTx 

NoTx 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

CL 

DD* 

CH 

DD* CL CH 
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Modbus ASCII Format 

FC Action 
Byte Number 

1 2 3 4 5 6 7 8 9 10 11 12 13 

05 

05 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

WW 

WW 

WW 

WW 

LRC 

LRC 

CR 

CR 

LF 

LF 

   

10 

10 

Request 

Response 

: 

: 

MA 

MA 

FC 

FC 

RA 

RA 

RA 

RA 

NR 

NR 

NR 

NR 

NB 

LRC 

DD* 

CR 

DD* 

LF 

LRC CR LF 

Message Examples for Device Address = 01, No Parity 

Example Action 
Modbus RTU Modbus ASCII 

Ser_4 = 010     Addr = 001 Ser_4 = 020     Addr = 001 

Send -12.34 

to LTS ** 

First send decimal point, address 0057 as 00 03. 

Request 

Response 

01100069000204FFFFFB2EF6E5 

01100069000291D4 

:01100069000204FFFFFB2E59crlf 

:01100069000284crlf 

** 1234 decimal = 000004D2 hex.  -1234 = FF FF FB 2E in 4-byte 2’s complement hex.   

Decimal point is ignored. 

 RTU: Bolded last 4 characters indicate the CRC (added automatically by the device). 

ASCII: Bolded last 2 characters indicate the LRC ((added automatically by the device). 
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11.  CUSTOM ASCII PROTOCOL TRANSMITTER COMMUNICATIONS  

 

All setup parameters are entered into the transmitter via Instrument Setup (IS) software, 

including the serial communication format, digital address, operating mode, analog output 

scaling, and relay operating modes and setpoints. 

1.  SERIAL COMMUNICATION FORMAT 

The Custom ASCII serial communication format for both RS232 and RS485 is the following: 

Modes ............... Full Duplex (separate transmit and receive lines) or Half Duplex (RS485 only). 

Baud Rate ......... 300, 600, 1200, 2400, 4800, 9600, 19200 selectable with IS software. 

Data Format ...... 8 data bits, no parity, 1 stop bit 

2.  DATA FORMAT 

The basic input data format consists of 9 or 10 ASCII characters, such as +9999.99A<CR>. The 

first character is always a plus or minus sign. There are 6 numeric digits. A decimal point is 

always required, even when it follows the last digit. The letter A is an optional alarm character. 

<CR> is the carriage return character. A line feed <LF> character at the end of the string is 

ignored. 

3.  NETWORK CONFIGURATIONS 

Using the Custom ASCII protocol, serial input transmitters can operate in a point-to-point mode 

using RS232 or RS485, or in a multi-point mode using RS485: 

The point-to-point mode is a direct connection between a computer (or other digital device) 

and the transmitter. It is suggested that address 1 be selected for the point-to-point mode. 

The multi-point mode is a connection from a host computer to multiple transmitters bused 

together with their inputs and outputs connected in parallel. It is necessary to set up each 

device on the bus with a different address from 1 to 31. To command a particular device, its 

address is used in conjunction with the command, and only that device will respond. The 

outputs of all devices on the bus are set to a high impedance state, except the device being 

addressed. Zero (0) is a special address to which a device responds only internally (e.g. Reset), 

but it does not transmit any response on the output lines. All devices may be commanded 

simultaneously with a 0 address, and there will not be any output response contention.   

4.  OPERATING MODES 

The serial input transmitter has three serial input modes, which are dedicated to the analog 

output and relays based on serial data received via RS232 or RS485: 

Remote A ........ Addressable remote units (up to 31 units) 

Remote S ........ Single remote unit 

Remote C ........ Single remote unit programmed to select specific data from a data string. 
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Remote A is an addressable input mode that uses the K command letter. It can convert remote 

data on one or more transmitters having the command address in a multi-point configuration 

or a single transmitter having the command address in a point-to-point configuration. 

Remote S is not addressable, and data representing a value to be retransmitted as an analog 

output is received via a point-to-point connection. The value is stored where it may be selected 

for Alarm comparisons. If a Coded Alarm character is included, it overrides the internal alarm 

comparisons.  

Remote C is used to extract data from an ASCII string that contains multiple data values and 

non-numeric characters. It can accommodate selected Start and Stop characters. Any number 

of characters after the start character can be masked off up to the beginning of the desired 

data. From 1 to 6 numeric characters can be selected for the data (8 characters if sign and 

decimal point are included). The following parameters determine the operation: 

1.  Start character. This can be any ASCII character in the received string. It must be at a 

fixed number of characters from the beginning of the desired data, which must have a 

fixed number of characters. Enter 00 if no start character is available. The stop charac-

ter then becomes the start character.   

2.  Stop character.  Set to 00 if no stop character is available. Note: Only either the start or 
stop character can be set to 00. The start and stop characters cannot be any character 

included in the data string.  

3.  Skip No.  Number of characters following the Start character to be ignored. 

4.  Show No.  Number of characters following the ignored characters to be processed. 

Warning:Warning:Warning:Warning: Instrument Setup (IS) software sets the mode to Remote A when 

first accessing the transmitter or performing a Get Setup command. This is 

because the transmitter will not communicate with the host PC using IS 

software in the Remote C mode. The user must reset the mode to Remote 

C prior to executing a Put Setup command, which will load the setup 

information into the transmitter. 

If you desire the transmitter to operate in the Remote C mode and you later need to perform a 

Get Setup command to change a setup parameter, do not forget to change the transmitter back 

from Remote A to Remote C prior to performing a Put Setup command. 

Remote A Data Format:  *#KSDDDDDD.A<CR> 

* =  Recognition character. Another command recognition character may be chosen 

to make the transmitter compatible with an existing system. The transmitter will 

still respond to an asterisk.  

# = Device address. See Address Codes table on next page. 

K =  Command letter. 

S =  Sign of value (optional), space (or +) for positive, - for negative value.  

D =  Data. Number of digits can be 1-6.  
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. = Decimal point (optional). 

A    =  Alarm Character (optional). A = no alarms, B = alarm 1 active, C = alarm 2 active, 

D = alarms 1 & 2 active. 

<CR>  =  Carriage return character 

Remote S Data Format:  SDDDDDD.A<CR>  

S =  Sign of value (optional), space (or +) for positive, - for negative value.  

D =  Data. Number of digits can be 1-6.  

. = Decimal point (optional). 

A    =  Alarm Character (optional). A = no alarms, B = alarm 1 active, C = alarm 2 active, 

D = alarms 1 & 2 active. 

<CR>  =  Carriage return character 

Remote C Data Format:  STXXXSDDDDDD.SP  

ST =  Start character 

XXX = Data to be ignored (Skip No.) 

S = Sign of value (optional), space (or +) for positive, - for negative value.  

D =  Data. Number of digits can be 1-6 (Show No.)  

. = Decimal point (optional). 

SP = Stop character 

CHAR 2 - Address Codes for Remote A 

A Serial Communications Address Code from 1 to V follows the “*” to indicate the device 

address number from 1 to 31. 

Device # 
Address 

Code 
 Device # 

Address 

Code 

 
Device # 

Address 

Code 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

1 

2 

3 

4 

5 

6 

7 

8 

9 

A 

B 

 12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

C 

D 

E 

F  

G 

H 

I 

J 

K 

L 

M 

 23 

24 

25 

26 

27 

28 

29 

30 

31 

N 

O 

P 

Q 

R 

S 

T 

U 

V 
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12.  SPECIFICATIONS, SERIAL INPUT TRANSMITTER  

 
Serial Data Input 

Signal Levels ...................................... RS232, full-duplex RS485, half-duplex RS485 (selectable) 

Protocol ................................. Modbus RTU, Modbus ASCII, Custom ASCII (software selectable) 

Serial Connector ........................................................................ Detachable dual 3-position plugs 

Analog Output (standard) 

Output Levels ............................................. 0-20 mA, 4-20 mA, 0-10V, -10V to +10V (selectable)  

Compliance at 20 mA .................................................................................. 10V (0-500 ohm load) 

Compliance at 10V ......................................................................... 2 mA (5 kohm minimum load) 

Output Resolution ....................................................................................... 16 bits (65,535 steps) 

Output Error ................................................................................................... < 0.02% of full span 

Output Update Rate .............. Determined by serial input rate. Approx 75/sec max at 19200 baud 

Dual Relay Output (standard) 

Relay Type .................................................. Two solid state relays, SPST, normally open, Form A 

Load rating ................................................................................... 120 mA at 140 Vac or 180 Vdc 

Relay modes ............... Active high or low, latching or non-latching, hysteresis or band deviation 

Power & Electrical 

Power to Transmitter ...............................................85-264 Vac or 90-300 Vdc (standard power) 

 .................................................................... 12-30 Vac or 10-48 Vdc (low voltage power option) 

Power Isolation .................. 250 Vrms between power, analog output, signal input, and serial I/O 

Transmitter Setup 

Transmitter setup ..................................... Instrument Setup software using PC and CBL04 cable 

Mechanical 

Case Dimensions ......................................................................................... 129 x 104 x 22.5 mm 

Case Mounting ................................................................................ 35 mm DIN rail per EN 50022 

Electrical Connections............................................................. Detachable screw plug connectors 

EnvironmentalEnvironmentalEnvironmentalEnvironmental    

Operating Temperature ............................................................................................... 0°C to 55°C 

Storage Temperature ............................................................................................... -40°C to 85°C 

Relative Humidity ........................................................... 95% from 0°C to 40°C, non-condensing 
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13. WARRANTY 

    

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for a 

period of one year from the date of purchase.   

In the event of a defect during the warranty period, the defective unit may be returned to the 

seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the 

defective unit at its option. In the event of such a return, freight charges from the buyer shall be 

paid by the buyer, and freight charges from the seller shall be paid by the seller. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

 1. Improper installation or miswiring. 

2.2.2.2. Improper or inadequate maintenance. 

 3. Unauthorized modification or misuse. 

 4. Operation outside the environmental specifications. 

 5. Mishandling or abuse. 

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 

expressed or implied. Laurel specifically disclaims implied warranties of merchantability and 

fitness for a particular purpose. 

Any electronic product may fail or malfunction over time. To minimize risks associated with 

reliance on Laurel products, users are expected to provide adequate system-level design and 

operating safeguards. Laurel’s products are intended for general purpose industrial or 

laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or 

aerospace applications, or for use in hazardous locations. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Laurel 

be liable for direct, indirect, incidental or consequential damages (including loss of profits) 

whether based on contract, tort, or any other legal theory. 
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